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any data retrieval system without prior written permission of the copyright owners.

This documentation is supplied on an as-is basis. Information contained within this docu-
mentation is subject to change at any time without notice and must not be relied upon.

All company and product names are ™ or Registered Trademarks ® of their respective
owners.
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Merging Technologies software.

Merging Technologies manufacturers importers or dealers shall not be liable for any inci-
dental damages including personal injury or any other damages caused by improper use
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Upgrade Procedure

Terminology
lggy = Name of Ramses software application and interface shown on Active Screen
Versions = Software
Firmware = For programming Hardware (flash)
Sets = Edit Bay Mappings
Scope

This document details the process of installing new software (and firmware).

Note: This procedure only applies to Ramses MSC consoles running V1.5.1 software and
above.

All versions of software and firmware installed are also kept in an archive. This eanbles users to downgrade
or upgrade to different versions of Ramses MSC Console software and firmware at will.

Note: all console software and firmware can be deleted from the list at any time and re-
imported at a later stage.

Availability

Ramses MSC Console software and firmware updates are available for download from the Merging Tech-
nologies website.

www.merging.com/ramses/download/

Alternatively, contact your Merging Technologies sales partner.

‘AMERGING Ramses MSC Software
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Software and Firmware Upgrades

Software upgrades are distributed as .zip files. Firmware upgrades are distributed as .bin files.

Files
There are two software files. These are named according to these conventions:
. Consolesoft 1.5.3.3032 2007.07.09 rms .zip
. Consolesoft 1.0.0.140 2007.05.07 monitor .zip

The single Firmware file named according to this convention:
. Consolefirm 1.5.2.31 2007.04.04 .bin

and the Edit Bay Set files are named according to this convention:

. Consolesoft set1 2007.08.21 1452 rms.zip

These can be installed using one of two methods:

Method 1 Install using a USB stick

Copy the files onto a USB stick. Insert the USB stick into a USB socket on the rear of the console. Then fol-
low the Upgrade Procedure below.

Method 2 Install from a Network Location

Users who have their engines connected to a LAN may upgrade by simply placing the software .zip file into
a remote network location. Then follow the Upgrade Procedure below.

Note: The console must first have been correctly set up to ‘see’ a mapped network drive.
(If necessary please see: Mapping a Network Drive on page 31).

This provides and extremely rapid and convenient method of updating software.

‘AMERGING Ramses MSC Software
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Ramses
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Upgrade Procedure

Software
1. Copy the new Software files onto a USB Memory Stick or Mapped Network Drive.

2. |If using the USB Stick method, plug this stick into a USB port on the rear panel of your Ramses MSC-
Console.

If not already running, start your console as per normal.

Press the System Button near the top of the Active Panel and then touch the Versions Touch Button.

| System Button

Versions
Touch Button
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5. You should now see all the available software Versions ready to be installed

Note: Software Versions have an .rms extension..

Currently
Installed Version

System - Versions [1. 5. 3. 2650 rms]

1.5.3.2650 2007.05.28 rms -+
1.5.3.2585 2007.05.15 rms
1.5.3.2525 2007 .05.01 rms
setl 2007.04.30 1544 rms

Active Knob
Moves Cursor

set0 2007.04 30 1544 rms
1.5.3.2321 2007 .04.13 rms
set9 2007.04.12 1722 rms
1.5.3.2308 2007 .04.11 rms
1.5.3.1959 2007 .03.13 rms
521017 2006.08.03 pmx

Notice that the currently installed version number is highlighted at the top of the screen.
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6. Press the Import Touch button to Import a new Version from a USB Stick (or Network location)

New Software Versions

0 on CDROM

1 on removable drive(s)

0 on mapped network folder(s)
Import all 7

Diteerigenc e

‘AMERGING Ramses MSC Software




Ramses MSC Software upgrade guide : Upgrade Procedure
Ramses [VISC

Console Control System

7. Press the Confirm Touch Button to Import all available Versions. The Imported Version(s) will now be
shown in the list:

System - Versions [1. 5. 3. 2650 rms]
1.5.3.2650 2007.05.28 rms
1.2.3.2590 2007.02.15 rms
1.5.3.2525 2007.05.01 rms
set1 2007.04.30 1544 rms
set0 200/.04.30 1544 rms

1.5.3.2321 2007.04.13 rms

set9 2007.04.12 1722 rms

1.5.3.2308 2007.04.11 rms
5.3.1959 2007.03.13 rms

1.5.
1.5.2.1017 2006.08.03 pmx

8. Turn the Active Knob (beneath the Active Screen) until the Arrow Cursor is next to the desired Con-
soleSoft x.x.x.xxxx. 20xx.xx.xx rms file version.

‘AMERGING Ramses MSC Software
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9. Press the Install Touch Button.

Confirm Install New Version

Current version :
1. 5. 3. 2650
New version :
1.5.3.2650 2007.05.28 rms

Install new version ?

Stem On

Divergence Shem O Sub Lenna|
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10. Press the Proceed Touch Button to Confirm that you wish to Install a different Version

Installing New Version

VWARNING!!

Do not interrupt this process!

Please Restart Console when finished.
1.5.3.2650 2007.05.28 rms

Install new version 7

Proceed Cancel

DivErgence Sherm On Sub Lenn|

Note: The process will take a few seconds.
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11. At the end of the the process the display reverts to the System - Versions screen:

System - Versions [1. 5. 3. 2650 rms]
1.5.3.2650 2007.05.28 rms

1.5.3.2595 2007.05.15 rms
1.5.3.2525 2007.05.01 rms
set1 2007.04.30 1544 rms
setl 2007.04.30 1944 rms
1.5.3.2321 2007.04.13 rms
set9 2007.04.12 1722 rms
1.5.3.2308 2007.04.11 rms
1.5.3.1939 2007.03.13 rms

1.5.2.1017 2006.08.03 pmx
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12. Press the Exit Touch Button to return to the root System screen.

System

Stems Firmware

Configure Shutdown

Divergence b L ez
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13. Press the Engines Touch Button

System - Engines

Divergence Shem O Sub Lenna|

14. Select Pyramix (if not already highlighted) and press the Restart Touch Button to restart Iggy

‘AMERGING Ramses MSC Software
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Edit Bay Sets

1. Copy the new Software files onto a USB Memory Stick or Mapped Network Drive.

2. If using the USB Stick method, plug this stick into a USB port on the rear panel of your Ramses MSC-
Console.

If not already running, start your console as per normal.

4. Press the System Button near the top of the Active Panel and then touch the Versions Touch Button.

| System Button

Versions
Touch Button
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5. You should now see all the available software Versions ready to be installed

Note: Edit Bay Sets Versions have an .rms extension and setx prefix..

System - Versions [1. 5. 3. 2650 rms]
1.5.3.2650 2007.05.28 rms -+

1.5.3.2595 2007.05.15 rms
1.5.3.2525 2007 .05.01 rms
set1 2007.04.30 1544 rms

Active Knob
Moves Cursor

Setx Versions ; set0 2007.04.30 1544 rms

1.5.3.2321 2007.04.13 rms
setd 2007.04.12 1722 rms
1.5.3.2308 2007.04.11 rms
1.5.3.1958 2007.03.13 rms
521017 2006.08.03 pmx
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6. Press the Import Touch button to Import a new Version from a USB Stick (or Network location)

New Software Versions

0 on CDROM

1 on removable drive(s)

0 on mapped network folder(s)
Import all 7

Diteerigenc e
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7. Press the Confirm Touch Button to Import all available Versions. The Imported Version(s) will now be
shown in the list:

System - Versions [1. 5. 3. 3298 rms]
set1 2007.08.21 1432 rms
set1 2007.08.21 1133 rms
set1 2007.08.21 1127 rms
set1 2007.08.21 0946 rms
set0 2007.08.20 1834 rms
1.5.3.3298 2007.08.15 rms

1.5.3.3292 2007.08.14 rms
1.5.3.3125 2007.07.24 rms
1.5.3.3120 2007.07.23 rms
1.5.3.3032 2007.07.09 rms

Stamn C

8. Turn the Active Knob (beneath the Active Screen) until the Arrow Cursor is next to the desired Con-
soleSoft setx 20xx.xx.xx rms file version.

‘AMERGING Ramses MSC Software
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9. Press the Install Touch Button.The Confirm Install New Version screen appears:

Confirm Install New Version

Current version :
1. 5. 3. 3298
New version :
set1 2007.08.21 1452 rms

Install new version 7

0 g e Sl |

Stern O
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10. Press the Proceed Touch Button to Confirm that you wish to Install a different Set Version

Installing New Version

VWARNING!!

Do not interrupt this process!

Please Restart Conscle when finished.
1.5.3.2650 2007.05.28 rms

Install new version 7

Dirveraence Stem On Sub Leval

Note: The process will take a few seconds.

‘AMERGING Ramses MSC Software




Ramses MSC Software upgrade guide : Upgrade Procedure

Ramses IVISC

Console Control System

11. At the end of the the process the display reverts to the System - Versions screen:

y N—

System - Versions [1. 5. 3. 3288 rms]
set1 2007.08.21 1452 rms
set1 2007.08.21 1133 rms
set1 2007.08.21 1127 rms
set1 2007.08.21 0946 rms
set0 2007.08.20 1834 rms
1.5.3.3298 2007.08.15 rms

1.5.3.3292 2007.08.14 rms
ARsEa 2007.07.24 rms
RS 2007.07.23 rms

1.5.3.3032 2007.07.09 rms
m

Stem C

Ramses MSC Software
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12. Press the Exit Touch Button to return to the root System screen.

System

Stems Firmware

Configure Shutdown

Divergence b L ez
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13. Press the Configure Touch Button to enter the Configuration pages:

System - Configure

Engine Type~

Engine Type~

Ramses + Pyramix V6

List (Active Controls)

Do e Stermn On

Note: The System - Configure page you actually see will depend on the page last viewed.

‘AMERGING Ramses MSC Software
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14. Navigate in the Configure Page using the Next button until you reach the Edit Bay Configuration
page:

System - Configure

Edit Bay Configuration (0O=stan

Edit Bay Configuration (0=standard)~

Numeric (Active Controls)

Difarance Stem On

15. To activate the newly installed Set, make sure that the Edit Bay Configuration is set to 1. If this is not
the case then use the Active button to set it to 1.

Note: 0 is the default Ramses Set and bypasses the currently installed Set.

‘AMERGING Ramses MSC Software
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16. Press the Save Touch Button to save the change (if any) and to return to the root System screen..

Engines Versions
Stems I EE

“ P.J Etlllﬁllro r L;

Configure Shutdown

DR royence
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17. Press the Engines Touch Button

System - Engines

Divergence Shem O Sub Lenna|

18. Select Pyramix (if not already highlighted) and press the Restart Touch Button to restart Iggy

‘AMERGING Ramses MSC Software
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Firmware

Note: Firmware upgrades should only be undertaken when absolutely necessary. It is
imperative that the console is not switched off while firmware is being flashed. Failure to
observe this warning may result in damage to your console.

1. Press the System Touch Button near the top of the Active Panel and then touch the Firmware Touch
Button.

| System Button

I Firmware
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2. You should now see all the available firmware ready to be installed

Note: Firmware revisions appear in the list with NO file extension.

System - Firmware
2007.04.04
2007.01.10
2006.08.15

CUursar Stem ©

3. Toimport a new Firmware revision press the Import Touch Button followed by the Confirm Touch But-
ton to import all available firmware.

4. Place the cursor next to the desired revision of Firmware using the Active Knob
Press the Install Touch Button followed by Overwrite and then Confirm on subsequent screens.

Note: The flash upgrade process can take between 15 and 30 MINUTES

WARNING!!!
DO NOT SWITCH OFF THE CONSOLE

‘AMERGING Ramses MSC Software
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6. Now press the System Button

System

Engines

Stems

Errors

Configure

Confirm

DivErgence

Press the Shutdown Touch Button followed by Confirm. This will shut down the console.
Wait 20 seconds
9. Power On the console

10. Your Ramses MSC Console is once again ready for use.

Congratulations! — your RAMSES MSC CONSOLE is now ready for use with the new Software and or
Firmware.

‘AMERGING Ramses MSC Software
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Mapping a Network Drive

Note: This is procedure is only required to allow new console software to be imported with-
out using a USB memory stick. If you are not planning to import software over a network,
this need not be setup.

In order to be able to install Ramses MSC Console software or firmware from a remote network location,
please follow the procedure described below:

Note: This procedure assumes that you are logged onto the Iggy PC as the default user
and have all the appropriate rights to access your network.

1. Attach a USB Mouse and Keyboard to the console.
2. Press the System button followed by the Config Touch Button

3. Use the Prev / Next Touch Buttons to find the Hide Mouse cursor page.

System - Configure

Hide mouse cursor

Hide mouse cursor

FALSE

On/Off (Active Button)

Freq Band 1 On Band 1

4. Ensure that the Hide Mouse Cursor option is set to FALSE (If necessary toggle using the Active But-
ton)

‘AMERGING Ramses MSC Software
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5. Open the Windows Start Menu by pressing the Windows key on the USB keyboard or Ctrl + Esc

r - I

My Computer

@mmmm o ik
-ww %mm

@ Hobepad : =7 Eun...

Note: Windows screens are 90 degrees shifted in orientation. This is normal.

6. Open My Network Places and browse to your workgroup

Fewordgroup =18 x|
Fle Edt Wew Favortes Took  Help | &
@m - Q - ._’:_‘)—-"m |f | Folders | [edé L3 x H’|-

Address [y workgroup = Qe
[ tame = | Comments |

i Brm_7ade81

i Chis (Chris) Chris

i Eliare PC (Ekan) Elar PC

¥y Joes Notebook Computer (30...  Joes Motebook Computar

"jmnb.wttrwv} sanmba server

i Matks Laptop (Matt) Matts Laptop

I Pyraenic: Demo System (Pyramix) Pyramix Demo System

i Office Computer 1 (Smarti)  Office Computer |

i Professionsl Series Smart Con... Professional Series Smart Cansols
i Senart Server (Smartserer) Smark Seryer

‘AMERGING Ramses MSC Software
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7. Browse to the remote Network Folder you want to map as a Network Drive. This is where you would
like the console to look for new versions of software and firmware. For example \\Server\ConsoleSoft.

B Consolesoft E= gj_a.lﬁ
| &
Qe - () - (T Jseweh | w5 3 X 9|7
Yomart: SHEREVSOF T gy distribition new] Consolesoft ;I GCI
 hame = | Size | Type [ Date Modfied |
Cyod Fie Folder £/13/2007 11:13 &M
(] conseiessft 1000, 140 2007.05.07 monkar 2 IOKE Compressed{sippe...  7/9/2007 2:32PM
(] consclesalt 1,5.3.2619 2007,05.21 gt .5p 1,977 KB Compréssed (sppe...  SI21/2007 3:05 PM
(L) cansclesoft 1,5.3,2700 2007.06.01 stp .op 1,960 KE Compressed (zppe... 6/1/2007 1:26 PM
10 consolesalt 1,5.%.2762 2007.06.05 bac .20 ZOI9KE Compressed (gppe...  &/S72007 1:07 PM
(1 consclesaft 1.5.3.2852 2007.06. 13 hui .2ip 2,004 KB Compressed (sippe...  Gf13[2007 10:42 AM
[ consclesolt 1.5.3.2682 2007.06. 13 i .2ip 2024KE Compressed{zppe...  B/13[2007 6:13 FM
(1 cansclesolt 1,5.3,3083 2007.07.17 nue .2p 2,001 KB Compressed (zippe...  THI7[2007 3:44 PH
({1 consclesoft 1,5.3,3087 200707, 17 nus .20 2,001 KB Compressed (sppe...  7/17/2007 5:06 PM
(1 Conscesaft 1,5.3.3102 2007.07. 19 s ,2ip 2,000KE Compressed (zppe...  TII9[2007 4:46 P
(1 consclesalt 1,5.3.3120 2007.07.23 ms .2ip 1,999 KB Compressed (zppe...  7/Z3/2007 5:51 PM
({7 consolesalt 1,5.3,3128 2007.07.24 s .2ip 1,999 KB Compressed (zppe...  7/24/2007 6:33 PH
(1 consclesslt 1,5.3.3132 2007.07.31 pmx .5p 1,999 KE Compressad (sppe...  7[31[2007 1:21 PM
[ Consotesaft 1,5.3,3160 2007.08.07 pmx .2ip 1,999 K6 Compressed (oppe...  87/2007 L1:34 AM
{0 Consolesolt 1,5.3,3212 2007.08,08 pmx .3p 1L,S¥9KE Compressed (dppe...  B/AJ2007 1:26 PM
[0 consoliesalt 1.5.3,3241 2007.08.13 pmx .3ip 2,006 KB Compressed{zppe...  8f13[2007 11,28 AM
1] consclescit 1.5.3, 3253 2007.08. 13 proc .2 2,002 KE Compresced (Zppe...  BI13[2007 12:34 PM
(1) consoliesoft 1.5.3,3255 2007.08. 13 pm .2ip Z,003KE Compressed (Zppe...  SM13[2007 1:12 PM
(10 Consolesaft 1.5.3,3271 2007.08, 13 pma .2ip Z003KE Compressed (gppe...  SIL32007 3:37 PM
[ Conschesslt 1,5.3, 3276 2007.08, 13 pinc 5ip 2,003KE Compressed (sppe...  Bf13/2007 6:01 PM

8. Select the Network Address in the Address Bar and copy the address into the edit buffer using Ctrl +
C or selecting Edit > Copy from the menu.

9. Re-Open the Start Menu (Windows Key or Ctrl + Esc)

0 My Computer

' . My Network Places
@'Mh?ﬁﬂ |

[ Geotretpanei
-wm %mm "

=
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10. Open a Command Prompt Window

in Band 1

Freq Band 1

11. Type the following line:
net use x: \Servername\Foldername /PERSISTENT:YES followed by Enter

(\\Servername\Foldername can be added by Pasting (Ctrl + V) the address copied in Step 8 above)
You should then see, The command completed successfully appear in the Command window.

(In our example the exact line is: net use x: \Smartserve\SHARE\SOFT-
WARE\Iggy_distribution\_Consolesoft /PERSISTENT.YES)

See the screen shot below:
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wEmart Alnet use = Adelete

asDocuments and BrnartzerversSHARESE0FTWARE] oo
diztribution_ne L
he command completed successFully.

asDocuments and SettingssSnmart AV>_

Note: If a Username and Password is required to access your Workgroup then the
shared drive may well be disconnected after a Ramses start-up or re-boot. In order to
avoid the possibility of this problem occurring please add the Ramses MSC console as a
user on your server. Username: Smart AV. There is no password set so please leave the
Password field blank.
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12. Re-open the Start Menu (Windows Key or Ctrl + Esc) and open My Computer

Fle Edt View Favorkes Took Help |_ﬁ'

w |l€)E - e T | PO [ roders |5 3 X 6 |
EHE

| Type | =

Fils Folder
File Folder

Freq Band 1

Adidress | 'y My Computer

[ Shared Docusments
[ Smart AY's Documents

Hard Disk Drives

<eeLocal Disk (C:)

Network Drives

Freq Band 1

13. Scroll down to find the newly mapped Network Drive. Now, click on it to select it then right-click and
choose Create Shortcut

14. You will see the following message telling you that Windows cannot create a shortcut here and ask-
ing if it should be placed on the desktop instead.Click on the Yes button

Edt ‘View Favoetes Took Help

@m - Q) - (| Jsemh

roders | |5 5 X 1) |

'Wmljwr:mw

EE

Hame | Type

e Shared Documents File Foldar
©

H

]

? J Windows carnot reste & dheateut beie,

- oo youn weant e shyortout o be placed on the deskbop instesd?
g

M s I Ho

S Consokesoft on ‘Smastserver]SharelSoftware,
4]

atwiork Drive

4

y N—
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15. Using the open explorer window, navigate to the Desktop folder under C:\Documents and Set-
tings\Smart AV\Desktop

Fle Edt Wew Favortes Took  Help
Qe - © - (T | Psewen |7 s | |5 5 X 6|
Address | ) C/\Documents and Settings|Smart AV\Desktop s

Hatms_= | Size | Type | Diates Mockfied
2 shorteuk o _Consolesoft on ... 1B Shorteut B/14{2007 11

16. Select the shortcut you've just created and rename it X (the drive letter)

17. Re-Open the Start Menu (Windows Key or Ctrl + Esc). Click on All Programs > Startup then right-
click and select Explore. This will open an Explorer window into which we need to move the shortcut.

.. 01

- =lolx|
4
ig‘III'II!"hl:rm:.nmzq B ¥ Comastax s || 2 X Q| 7
% J My Network Places = @ |
%'Iwrlwm [ rype | iate ModFied
[}iﬂmd Panel Shortout B/14/2007 11
-l:-rmuﬂ?mnut
W connect To v
@WM e,
émmhﬁwu xﬁlms
@Emw Explore Al | ers
Dielete i
FLarame
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18. Use Alt + Tab to return to the Desktop Explorer window then select and Cut (Edit > Cut or Ctrl + X) to
remove the shortcut.

CFie [Edt Vew Favortes Took  Heb | &
[ B S T
m“mt‘mm = &
Mame  Paste Chiey Size | Type [ st trcdiind
- B 148 Shortoe 8/14/2007 11

Copy To Folder. ..
Mo To Folder,,,

Select A1 Chrlled
Trwert Selsction

i ___1"53"‘_""‘ _-|;‘ g | ]

19. Use Alt + Tab to return to the Startup Explorer window and paste the shortcut into the Startup folder
(Edit > Paste or Ctrl + V)

an.- Edt  View Rrorkos. ~ Toll:. Pilp

Om -0 3| mms o | ) X8

Address | C:\Documents and Settings\Smart A¥|Desktop | s
T I =y [ o
View »En
furange Toons By L3
Refresh
Fil=  Edt Y¥iew Favontes 'I'ru-:ls I-lab Customiza This Folder...
Bad. - »'Snm:h
@ d ? |} ]d Pa<te Shartout
Folders th 2 Unda Move iz
) Fanorites .‘_'I [ desktop.in o =
B ) Local Settings
3 My Doouments Properties
) Methood
) PrirtHood
L Recent
L SendTo
B 1 Sert Meny I
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20. Right-click on the X shortcut you’ve just created and select, Properties
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22. Click on the Apply button followed by OK to exit.
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23. Re-open the Start menu (Windows Key or Ctrl + Esc) and verify that the X shortcut is in the Startup
folder.
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24. Close all the open windows and Shutdown and Restart the Console. The mapped network drive will
now be open in the background and you can undertake version and firmware imports via the network
drive.

25. Finally, remember to hide the cursor again in the SYSTEM > CONFIG page.

Please refer to Upgrade Procedure on page 7 for detailed instructions about installing new software Ver-
sions and firmware to the Ramses MSC Console.

Should you have any problems with carrying out this procedure, please consult your resident IT specialist.

Removing a Mapped Network Drive

To REMOVE the mapped network drive follow Steps 1 to 10 above to open a Command Prompt Window
and type the following:

net use x: /DELETE followed by Enter
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